
tonos cián, magenta, amarillo y negro
que las componen. Aunque el rango de
colores o gama, que puede ser alcanzado
en la impresión CMYK es menor que la
gama que se puede obtener en un moni-

CMYK en Linux. Como se mostró el mes
pasado, la composición CMYK es la
clave principal de la publicación profe-
sional. Con este proceso, las imágenes
en color pueden ser divididas en los

E
l mes pasado, mostré como crear
proyectos en Scribus y realicé los
primeros pasos para maquetar

nuestro periódico de ejemplo impor-
tando e insertando el nombre del pe-
riódico. También dimos un breve repaso
a cómo insertar textos en los marcos de
texto. Este mes, detallaremos como
introducir, ajustar, encajar y resaltar el
texto. Pero primero, empezaremos con la
tarea de colocar una fotografía en la
primera página.

Importación de Imágenes
La imagen es una fotografía u otro grá-
fico que acompaña al artículo y se sitúa
cerca de la parte de arriba de la página.
El fichero de imagen se crea por sepa-
rado y luego se importa en Scribus.
Empezaremos colocando una imagen
central en la primera página de nuestro
periódico Linux.

Un problema con la importación de
una imagen en Scribus es la carencia
general del soporte del espacio de color

En la segunda parte de esta serie de tres artículos [1], Jason Walsh se mete en detalles sobre como maquetar

un periódico con Scribus. Además nos enseñará como manejar los ficheros gráficos CMYK. 

POR JASON WALSH
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Está disponible una versión binaria del
plugin gimp-cmyk, compilada para Suse
Linux 8.0 de la página de los desarrolla-
dores en: http://www.blackfiveservices.
co.uk/separate.shtml

Si desea compilar su propia versión o
usar una distribución Linux diferente,
necesitará tener las bibliotecas de
ficheros para GTK, GIMP, LibTIFF y
LCMS instaladas. Si lo hace, es tan sen-
cillo como:

make clean 

make

Muchas distribuciones Linux incluyen
gimp-cmyk como parte de sus instala-
ciones estándar de GIMP. Por ejemplo,

esta serie fue producida usando SuSE
Linux 9.1 y gimp-cmyk se instaló por
defecto.

Si gimp-cmyk está instalado en su sis-
tema, se pueden convertir las imágenes
RGB al formato CMYK pulsando con el
botón derecho sobre la foto y seleccio-
nando Image del menú.

El plugin CMYK de GIMP es útil para
nuestros propósitos, pero un flujo de tra-
bajo que no maneja CMYK en todos los
pasos no es del todo ideal. En un futuro
próximo, los desarrolladores de GIMP
planean cambiarse a una biblioteca grá-
fica más genérica llamada GEGL. Este
cambio permitirá el soporte nativo de
CMYK.

Instalación del Plugin gimp-cmyk

Maquetación profesional con Scribus

TIPOGRAFIA Y
TEXTOS

039-043_Scribus_linux5  20.04.2005  12:12 Uhr  Página 39



logo que aparece se selecciona New. En
la ventana que aparece se definirá nues-
tro estilo de línea (Figura 2).

En la parte de arriba de la ventana se
introduce un nombre para el estilo, como
Línea de 2pt. También en la ventana
encontramos opciones para ajustar los
finales de las líneas y como se juntan
unas con otras. Para nuestro proyecto,
dejaremos estas opciones tal y como
vienen por defecto: Flat Cap y Miter Join.

A continuación, establezca el ancho de
la línea a 2pt y el color a negro. Para ter-
minar, púlsese OK y el estilo quedará
definido.

Para aplicar el estilo, se pulsa con el
botón derecho en la imagen y en la ven-

tana de propiedades que aparece se
selecciona Show Properties. Se escoge la
opción Line y se selecciona nuestro
estilo recién creado de la lista de la
parte de debajo de la ventana. Este pro-
ceso de definir un estilo y aplicarlo a
una imagen es la clave de la maque-
tación profesional, ya que deja al
usuario crear disposiciones consistentes
rápidamente y con la ventaja de que se
pueden rehusar a lo largo de todo el
documento.

Limpieza la Página
El proceso que acabo de describir hay
que repetirlo para la pequeña columna
de la derecha: hay que dibujar un marco,

tor con el rojo, verde y azul, la mayoría
de los tonos pueden ser reproducidos de
forma correcta.

El editor gráfico más importante de
Linux es el GIMP, que es, a efectos prác-
ticos un clon de Photoshop. Sin
embargo, a diferencia de Photoshop,
GIMP no soporta el manejo de imágenes
en el espacio de color CMYK. Afortu-
nadamente GIMP 2.0 ofrece un soporte
básico de CMYK con el plugin
gimp-cmyk (véase el cuadro titulado
“Instalación del plugin gimp-cmyk”). El
plugin gimp-cmyk permite a los usuarios
convertir una imagen RGB a capas
CMYK individuales (usando Perfiles de
Color como origen y destino) y guardar
esta colección de capas como TIFF
CMYK.

Para importar una imagen en Scribus,
primero se selecciona New Image Frame
de la barra de herramientas de Scribus y
se hace click y se arrastra el marco hasta
que se obtiene el tamaño más o menos
deseado.

Luego se importa la imagen seleccio-
nando File>Import>Get Picture.

Acabado de la Imagen
Una vez que la imagen ha sido impor-
tada, se coloca en el lugar exacto donde
se quiera situar y se redimensiona si
fuera necesario.

Cada publicación tiene su propio estilo
y esto se refleja en las guías de estilo. El
“East Belfast Observer” coloca una línea
negra de dos puntos de ancho alrededor
de cada imagen. Esto no sólo le da un
aspecto clásico sino que sirve para un
propósito técnico. Muchas de las prensas
de los periódicos están descalibradas. Esto
quiere decir que las cuatro planchas de
color se desalinean dando como resultado
una imagen difuminada y sus bordes se
salen del marco reservado a la misma.
Una línea de dos puntos de grosor tiene el
doble de ancho de una línea normal y es
muy raro que una de las planchas de color
tenga una descalibración mayor de dos
puntos. Así pues, si la prensa está descali-
brada, la línea negra ayudará a disimu-
larlo en el resultado final.

Como todas las fotografías de nuestro
proyecto tendrán esta característica,
tiene sentido que creemos un estilo que
se pueda aplicar a cualquier imagen sin
tener que hacerlo a mano cada vez.

Para crear el estilo, se selecciona
Edit>Line Styles. En el cuadro de diá-
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Las imágenes en la pantalla como las
que puede ver en la web tienen tradi-
cionalmente una resolución de 72 pun-
tos por pulgada. Eso significa que cada
pulgada de la imagen se compone de 72
puntos. Si intenta imprimir las imágenes
de la web, se verán mal,
ya que esta resolución es
demasiado baja para la
impresión.

Cuando se imprime en
casa, la mayoría de la
gente crea imágenes con
una resolución de 300dpi.
Esta es una resolución
bastante aceptable, sufi-
cientemente alta para la
mayoría de los propósi-
tos - de hecho es innece-
sariamente alta para un
periódico.

Para determinar que
resolución usar en nues-
tras imágenes, es impor-
tante comprender que
sucede con ellas. Las imá-
genes impresas consis-
ten en puntos con semi-
tonos. (Si escanea un
página de un periódico o
revista podrá ver estas
tramas de semitonos -
véase la Figura 1).

Los semitonos no se
miden en puntos por
pulgadas (dpi), sino en líneas por pul-
gada (lpi). Este proceso se llama
screening. Cuanto más alto sea el valor
lpi, mayor número de puntos habrá por
pulgada; el resultado final será una
imagen de alta resolución. Los periódi-

cos se imprimen a 65-85lpi, las revistas
a 100-150lpi y los libros entre 150-
300lpi.

Cada punto de semitono es a su vez
compuesto por puntos más pequeños
medidos en dpi. El dpi efectivo es el

máximo número de
estos puntos que la
impresora puede
imprimir por pulgada.

La razón entre dpi y lpi
está normalmente entre
el 150% y 200%. Así, si
su pantalla de semi-
tonos tiene 85lpi, sus
imágenes necesitan
tener una resolución
mínima de entre
127.5dpi y 170dpi.

La baja resolución rela-
tiva de la pantalla de
semitonos, 85lpi, es ade-
cuada para los periódi-
cos porque la tinta se
esparcirá por el papel de
baja calidad usado para
imprimirlo.

Por supuesto que no
hace ningún daño tener
las imágenes a mayor
resolución, así que todas
nuestras imágenes
podrían tener una reso-
lución de 200dpi por
seguridad. Mientras esta

resolución es bastante alta para un per-
iódico y permitirá que las imágenes se
puedan ampliar ligeramente, si las imá-
genes de 200dpi se imprimen para una
revista en un papel de alta calidad, el
resultado será bastante pobre.

Resolución

Figura 1: Una imagen publici-

taria del cómico Bill Bailey

escaneada de un periódico

Irlandés. Fíjese en la trama de

puntos de semitonos que se

encuentran por toda la imagen.
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importar la imagen, ajustar el tamaño y
aplicar el estilo.

Un breve comentario relacionado con
la fotografía irá debajo de la imagen. Por
el momento lo ignoraremos pero vamos
a dejar un espacio para ello. Debajo de
este comentario va el código de barras
ISSN y un anuncio.

Los anuncios son imágenes que se
crean en otra aplicación y se exportan
como Encapsulated PostScript (EPS). Se
importan exactamente igual que las
fotografías: se dibuja un marco y se
selecciona Import>Get Picture. Al con-
trario que las fotografías editoriales, los
anuncios no tienen la línea de dos pun-
tos de grosor que las rodean, sino que
tienen un borde de un punto de grosor
que forma parte de la propia imagen
antes de ser importada.

Con el código de barras sucede exacta-
mente lo mismo, otro fichero EPS,
aunque esta vez se crea con una apli-
cación especializada. De nuevo, no se
necesita colocarle un borde.

Al Texto
Ahora que nuestra imagen está colocada,
prestaremos nuestra atención al texto. El
primer paso es seleccionar un tipo de
letra. Muchas fuentes han sido diseñadas
específicamente para los periódicos. Para
el diseño de un periódico
serio, es necesario inves-
tigar y desarrollar el tipo
de letra.

En el caso del “East
Belfast Observer”, el
cuerpo del texto (es
decir, el texto de los
artículos reales) está
puesto con la fuente lla-
mada News 701. La
News es una fuente serif,
que es legible incluso
con tamaños pequeños,
perfecta para un per-
iódico. Como no tengo
una licencia para usar
esta fuente en este
proyecto la sustituiré por otra fuente
serif, Bauer Bodoni. Cualquier fuente
serif bien diseñada, como la Times, será
adecuada para el cuerpo del texto, pero
las fuentes como la News tiene ventajas
de espacio al estar diseñadas específica-
mente para su uso en periódicos.

Para finalizar, la clave para un buen
uso de las fuentes es bastante sencilla:

escoja tan pocas fuentes como le sea
posible y adáptese a ellas. Esta solución
le ofrecerá consistencia y claridad al lec-
tor.

En nuestro caso, todos los titulares
serán variaciones en negrita de la

fuente Gill Sans. En el
caso de los artículos,
será mejor importarla
de los ficheros de texto,
pero para los titulares,
simplemente hay que
dibujar el cuadro de
texto, introducirlo y
ajustar el estilo.

Como con otros ele-
mentos del diseño de la
página, vamos a crear
un estilo para el cuerpo
del texto (el texto prin-
cipal del artículo) y
aplicarlo. Escoja
Edit>Paragraph Style y
seleccione New en la

ventana Edit Style. Nombre este nuevo
estilo como Body Text News (Figura 4).

Las opciones que vamos a usar son
las siguientes: La fuente será Bauer
Bodoni Regular a 10pt. El tamaño que
ha de seleccionar para su tipo depen-
derá de las medidas de la fuente parti-
cular. Por ejemplo, una fuente relativa-
mente grande como la News 701 se

pondría a 8pt, donde una Times, proba-
blemente la quisiera a 12pt.

El espaciado de la línea se ajusta al
110% del tamaño de la fuente, es decir, si
la fuente está a 10pt, use 11pt donde con
una fuente con 8pt sería 8.8pt, y así
sucesivamente. Esto es mucho más
rígido que el valor por defecto y le dará
al texto un aspecto más denso y serio.

La mayoría del resto de las opciones
son cuestión de gustos. En este caso, se
tomó la decisión de establecer los artícu-
los en formato justificado (el texto
cubrirá ambos bordes de la columna).
De nuevo, esto le añade un aspecto serio
al texto. Evítese a toda costa el centrado
y la alineación a la derecha: estas
opciones no son útiles para el cuerpo del
texto.

El resto de las opciones se pueden
dejar con los valores predeterminados.
Púlsese “OK” y volverá a la ventana
Edit Styles. Resalte Body Text News y
seleccione Duplicate. Cambie el nom-
bre a Body Text Comment y cambie la
alineación a Align Text Left. Pulse OK.
Así como los artículos de noticias se
benefician del texto justificado, hacien-
dolos parecer más denso, los comenta-
rios, las opiniones y los artículos de
entretenimiento se benefician de la
alineación a la izquierda, haciéndolos
parecer más ligero el borde derecho
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Figura 2: Edición de los estilos

de las líneas.

Figura 3: La primera página completa, sin el texto.
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tar el texto y hacerlo que coincida. Esta
es una de las razones claves por las que
las páginas son maquetadas por los
subeditores y no por los diseñadores:
una comprensión de las reglas del
lenguaje hacen que la historia fluya bien
a lo largo del artículo.

Editemos nuestro artículo de primera
página. Hay que dibujar un marco de

texto bajo el titular con la misma
anchura, pero lo suficientemente larga
como para que llegue al pie de la página,
digamos a unos 1,5 cm desde el margen.

Abajo, dibuje otro marco similar que
llegue al margen del pie de página. Este
marco contendrá información sobre más
cosas que contendrá el periódico y dic-
tará cuanto bajará la historia en la
página.

Se importa el texto de la forma nor-
mal. (Se resalta el marco de texto y se
selecciona File>Import>Get Text.) A
continuación, se aplica el estilo Body
Text News seleccionándolo de
Tools>Properties. En el cuadro de diá-
logo, seleccione el texto y escoja el estilo
apropiado (Body Text News). Luego, se
selecciona Shape y se marcan 3 colum-
nas. Recuerde hacer un espacio entre las
columnas de unos 2mm. Esto se hace
editando el valor en la sección Shape de
Properties.

Descarte el cuadro de diálogo Proper-
ties. Cualquier fichero de un tamaño
razonable valdrá. En este caso, estamos
usando una copia de las cien primeras
palabras de este artículo, ya que no te-
nemos acceso a la historia completa.

Ahora la mejor parte (o la peor, según
se mire): Hay que editar el texto manual-
mente para ajustarlo al espacio asig-
nado, justo como se haría con un proce-
sador de textos.

Toques Finales
Ya lo único que queda es darle los toques
finales a la página. En la Figura 6, se
puede ver los elementos restantes que se
necesitan añadir.

Primero, hay que añadir el titular para
el artículo secundario en
el lado derecho de la
página. La fuente para el
titular se ha establecido a
Gill Sans Bold; hay que
ajustar el tamaño para
que encaje.

Lo siguiente es, debajo
del primer artículo,
añadir de nuevo la fuente
Gill Sans Bold a los
detalles de los contenidos
internos del periódico.
Recuerde que ya hemos
dejado un marco para
ello.

A continuación, debajo
del nombre del periódico,

desigual. Cierre la ventana de Edición
de Estilos.

Importación y Ajuste del
Texto
Si se mira con detenimiento un periódico
se dará cuenta que, al contrario que la
mayoría de las revistas, los artículos
encajan exactamente en los espacios
reservados a ellos, sin
dejar espacios en blan-
cos debajo de la
última línea. Esto
ayuda a darle un
aspecto más formal y
profesional a las pági-
nas del periódico y
obviamente, pre-
tendemos replicarlo en
nuestro periódico de
ejemplo. Sutilmente,
ajustando el formato y
seguimiento del texto
se conseguirá el efecto
deseado, pero la única
forma de hacerlo de
forma perfecta es edi-
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¿Qué significan todos esos términos?

Serif y Sans-serif

Aunque hay muchas subcategorías, la
división básica de las fuentes está en
fuentes serif y sans-serif. Serifs son
pequeños detalles que se encuentran al
final de los trazos de las letras, represen-
tando en realidad marcas cinceladas por
los artesanos romanos.

Las fuentes Serif se consideran más ele-
gantes, sobrias, serias y legibles, así
pues son utilizadas comúnmente para
grandes bloques de texto - échele un vis-
tazo a una novela o periódico.

Una fuente sans-serif (o, menos
común, Grotesque) no tiene estos
detalles. Su aspecto moderno y
dinámico las hacen adecuadas para
elementos de textos grandes, como ti-
tulares, textos de carteles y libros de
arte moderno.

Leading y Line Spacing Line Spacing,
tal y como aparece en Scribus, es nor-
malmente conocido como leading - lead
se refiere a las tiras de plomo usadas
para crear el espacio entre las líneas en
los días de las imprentas mecánicas.

El leading permite a los diseñadores
alterar la densidad de los bloques de
texto. Los periódicos son bastante den-

sos y su espacio entre líneas es mayor
que los encontrados en revistas, folletos
o carteles.

Kerning y Tracking Cuando se diseña un
tipo de letra, el diseñador asigna a cada
carácter un ancho, permitiendo a los

caracteres consecutivos colocarse en
una línea sin que lleguen a tocarse. Sin
embargo, las intenciones de un di-
señador de tipos puede que no sean las
mismas que las suyas. El kerning le per-
mite ajustar manualmente el espacio
entre dos caracteres cualesquiera. El
tracking le permite aplicar una forma de
espaciado universal entre todos los ca-
racteres. Por ello, es una opción potente
y una vez que haya encontrado una con-
figuración que considere adecuada, será
mejor que no la vuelva a tocar y ajuste el
kerning manualmente para los cambios
futuros.

Diccionario de Tipos

Figura 4: El cuadro de diálogo usado para establecer los estilos del texto.

Figura 5: Tipos Serif y Sans-serif.
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pero por encima de la imagen principal
hay un destacado para la sección de
entretenimiento. Este destacado consiste
en un marco de imagen y un marco de
texto.

La última tarea es terminar los tres
destacados principales del encabezado
de la página.

Destacados
El mes pasado escribimos “The new
newspaper for East Belfast” en lo alto de
la caja de texto que está a la izquierda.
Ahora lo retomaremos y empezaremos el
proceso que añadirá el texto y las imá-
genes a las otras dos cajas.

Hay que dibujar un marco de texto
sobre la caja que está más a la izquierda y
hay que añadir las palabras: “The new
newspaper for East Belfast”. Ahora se
ajusta la fuente, el tamaño y el espaciado

de línea. Pondremos el valor de 42pt para
el tamaño del texto, Gill Sans Italic para el
tipo de fuente y 36pt para el espaciado de
línea. Hay que colocar el marco de texto
de modo que coincida con la caja azul.

A continuación, se dibujan dos marcos
de imágenes, cada una sobre las cajas de
texto restantes. Dentro de estos marcos,
importaremos fotografías, pero primero
tendremos que Ωtrazar” las imágenes.
Esto quiere decir que hay que dibujar
una línea alrededor de la zona de la ima-
gen que queramos usar, permitiendo a
Scribus que descarte el resto de la ima-
gen.

Se abre la imagen en el programa de
edición de imágenes que se prefiera. Si el
editor es el PixelFX!, Photopaint o GIMP
en Linux o Photoshop en Mac/Windows,
el proceso es similar y se explicará como
hacerlo en el artículo del próximo mes.

En nuestro caso estamos usando una
foto publicitaria de la actriz francesa
Audrey Tautou y una imagen promo-
cional de alta resolución de un iPod,
bajada de la página web de Apple.

Pare, Repita, Repita de
nuevo
Ahora, que casi hemos terminado la
primera página, el proceso se tiene que
repetir para el resto de las otras páginas.
La última página está emparejada con la
primera página y tradicionalmente en
los periódicos anglófonos, esta página
es de deportes. Las otras dos páginas
son la portada de la sección de entreten-
imiento y una página de noticias. Si ha
seguido las dos partes de este tutorial,
será capaz de crear páginas similares
fácilmente.

Y el mes que viene…
En el último artículo de esta serie, dare-
mos los toques finales a nuestras páginas
del periódico, explicando como usar
plantillas para crear documentos multi-
páginas y le echaremos un vistazo a la
forma en la que tendremos que llevar
nuestras páginas a la imprenta. También
tendremos nuestro periódico terminado
evaluado por un profesional. ■

Scribus • PRÁCTICO

43Número 05W W W . L I N U X - M A G A Z I N E . E S

Figura 6: La primera página completa.

Jason Walsh fue el
director artístico en
el East Belfast
Observer desde su
lanzamiento en
enero del 2004
hasta julio del 2004,
anteriormente fue el director artís-
tico de la revistas irlandesas
Gorgeus and CityCraic. Actual-
mente trabaja como periodista y ha
contribuido artículos a Linux Maga-
zine, Mute, The Guardian y muchos
otros periódicos y revistas de arte,
diseño y tecnología.
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[1] Para la primera parte de esta serie,
visita http://www.linux-magazine.es/
issue/04

[2] Scribus: http://www.scribus.org.uk/

[3] News Page Designer: http://www.
newspagedesigner.com/

[4] Society for News Design: http://www.
snd.org

[5] News Today: http://newstoday.com/
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